
How to write an Arduino library.

Writing a Library for Arduino
This document explains how to create a library for Arduino. It starts with a sketch for flashing Morse 
code and explains how to convert its functions into a library. This allows other people to easily use 
the code that you've written and to easily update it as you improve the library. 

For more information, see the API Style Guide for information on making a good Arduino-style API for
your library. 

We start with a sketch that does simple Morse code: 

int pin = 13;

void setup()
{
  pinMode(pin, OUTPUT);
}

void loop()
{
  dot(); dot(); dot();
  dash(); dash(); dash();
  dot(); dot(); dot();
  delay(3000);
}

void dot()
{
  digitalWrite(pin, HIGH);
  delay(250);
  digitalWrite(pin, LOW);
  delay(250);
}

void dash()
{
  digitalWrite(pin, HIGH);
  delay(1000);
  digitalWrite(pin, LOW);
  delay(250);
}
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[Get Code]
If you run this sketch, it will flash out the code for SOS (a distress call) on pin 13. 

The sketch has a few different parts that we'll need to bring into our library. First, of course, we have 
the dot() and dash() functions that do the actual blinking. Second, there's the ledPin variable which 
the functions use to determine which pin to use. Finally, there's the call to pinMode() that initializes 
the pin as an output. 

Let's start turning the sketch into a library! 

You need at least two files for a library: a header file (w/ the extension .h) and the source file (w/ 
extension .cpp). The header file has definitions for the library: basically a listing of everything that's 
inside; while the source file has the actual code. We'll call our library "Morse", so our header file will 
be Morse.h. Let's take a look at what goes in it. It might seem a bit strange at first, but it will make 
more sense once you see the source file that goes with it. 

The core of the header file consists of a line for each function in the library, wrapped up in a class 
along with any variables you need: 

class Morse
{
  public:
    Morse(int pin);
    void dot();
    void dash();
  private:
    int _pin;
};
[Get Code]
A class is simply a collection of functions and variables that are all kept together in one place. These 
functions and variables can be public, meaning that they can be accessed by people using your 
library, or private, meaning they can only be accessed from within the class itself. Each class has a 
special function known as a constructor, which is used to create an instance of the class. The 
constructor has the same name as the class, and no return type. 

You need a couple of other things in the header file. One is an #include statement that gives you 
access to the standard types and constants of the Arduino language (this is automatically added to 
normal sketches, but not to libraries). It looks like this (and goes above the class definition given 
previously): 

#include "Arduino.h"
[Get Code]
Finally, it's common to wrap the whole header file up in a weird looking construct: 
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#ifndef Morse_h
#define Morse_h

// the #include statment and code go here...

#endif
[Get Code]
Basically, this prevents problems if someone accidently #include's your library twice. 

Finally, you usually put a comment at the top of the library with its name, a short description of what it
does, who wrote it, the date, and the license. 

Let's take a look at the complete header file: 

/*
  Morse.h - Library for flashing Morse code.
  Created by David A. Mellis, November 2, 2007.
  Released into the public domain.
*/
#ifndef Morse_h
#define Morse_h

#include "Arduino.h"

class Morse
{
  public:
    Morse(int pin);
    void dot();
    void dash();
  private:
    int _pin;
};

#endif
[Get Code]
Now let's go through the various parts of the source file, Morse.cpp. 

First comes a couple of #include statements. These give the rest of the code access to the standard 
Arduino functions, and to the definitions in your header file: 

#include "Arduino.h"
#include "Morse.h"
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[Get Code]
Then comes the constructor. Again, this explains what should happen when someone creates an 
instance of your class. In this case, the user specifies which pin they would like to use. We configure 
the pin as an output save it into a private variable for use in the other functions: 

Morse::Morse(int pin)
{
  pinMode(pin, OUTPUT);
  _pin = pin;
}
[Get Code]
There are a couple of strange things in this code. First is the Morse:: before the name of the 
function. This says that the function is part of the Morse class. You'll see this again in the other 
functions in the class. The second unusual thing is the underscore in the name of our private 
variable, _pin. This variable can actually have any name you want, as long as it matches the 
definition in the header file. Adding an underscore to the start of the name is a common convention to
make it clear which variables are private, and also to distinguish the name from that of the argument 
to the function (pin in this case). 

Next comes the actual code from the sketch that you're turning into a library (finally!). It looks pretty 
much the same, except with Morse:: in front of the names of the functions, and _pin instead of pin: 

void Morse::dot()
{
  digitalWrite(_pin, HIGH);
  delay(250);
  digitalWrite(_pin, LOW);
  delay(250);  
}

void Morse::dash()
{
  digitalWrite(_pin, HIGH);
  delay(1000);
  digitalWrite(_pin, LOW);
  delay(250);
}
[Get Code]
Finally, it's typical to include the comment header at the top of the source file as well. Let's see the 
whole thing: 
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/*
  Morse.cpp - Library for flashing Morse code.
  Created by David A. Mellis, November 2, 2007.
  Released into the public domain.
*/

#include "Arduino.h"
#include "Morse.h"

Morse::Morse(int pin)
{
  pinMode(pin, OUTPUT);
  _pin = pin;
}

void Morse::dot()
{
  digitalWrite(_pin, HIGH);
  delay(250);
  digitalWrite(_pin, LOW);
  delay(250);  
}

void Morse::dash()
{
  digitalWrite(_pin, HIGH);
  delay(1000);
  digitalWrite(_pin, LOW);
  delay(250);
}
[Get Code]
And that's all you need (there's some other nice optional stuff, but we'll talk about that later). Let's 
see how you use the library. 

First, make a Morse directory inside of the libraries sub-directory of your sketchbook directory. Copy
or move the Morse.h and Morse.cpp files into that directory. Now launch the Arduino environment. If 
you open the Sketch > Import Library menu, you should see Morse inside. The library will be 
compiled with sketches that use it. If the library doesn't seem to build, make sure that the files really 
end in .cpp and .h (with no extra .pde or .txt extension, for example). 

Let's see how we can replicate our old SOS sketch using the new library: 
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#include <Morse.h>

Morse morse(13);

void setup()
{
}

void loop()
{
  morse.dot(); morse.dot(); morse.dot();
  morse.dash(); morse.dash(); morse.dash();
  morse.dot(); morse.dot(); morse.dot();
  delay(3000);
}
[Get Code]
There are a few differences from the old sketch (besides the fact that some of the code has moved to
a library). 

First, we've added an #include statement to the top of the sketch. This makes the Morse library 
available to the sketch and includes it in the code sent to the board. That means if you no longer 
need a library in a sketch, you should delete the #include statement to save space. 

Second, we now create an instance of the Morse class called morse: 

Morse morse(13);
[Get Code]
When this line gets executed (which actually happens even before the setup() function), the 
constructor for the Morse class will be called, and passed the argument you've given here (in this 
case, just 13). 

Notice that our setup() is now empty; that's because the call to pinMode() happens inside the library 
(when the instance is constructed). 

Finally, to call the dot() and dash() functions, we need to prefix them with morse. - the name of the 
instance we want to use. We could have multiple instances of the Morse class, each on their own pin
stored in the _pin private variable of that instance. By calling a function on a particular instance, we 
specify which instance's variables should be used during that call to a function. That is, if we had 
both: 

Morse morse(13);
Morse morse2(12);
[Get Code]
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then inside a call to morse2.dot(), _pin would be 12. 

If you tried the new sketch, you probably noticed that nothing from our library was recognized by the 
environment and highlighted in color. Unfortunately, the Arduino software can't automatically figure 
out what you've define in your library (though it would be a nice feature to have), so you have to give 
it a little help. To do this, create a file called keywords.txt in the Morse directory. It should look like 
this: 

Morse   KEYWORD1
dash    KEYWORD2
dot     KEYWORD2
[Get Code]
Each line has the name of the keyword, followed by a tab (not spaces), followed by the kind of 
keyword. Classes should be KEYWORD1 and are colored orange; functions should be KEYWORD2 
and will be brown. You'll have to restart the Arduino environment to get it to recognize the new 
keywords. 

It's also nice to provide people with an example sketch that uses your library. To do this, create an 
examples directory inside the Morse directory. Then, move or copy the directory containing the 
sketch (let's call it SOS) we wrote above into the examples directory. (You can find the sketch using 
the Sketch > Show Sketch Folder command.) If you restart the Arduino environment (this is the last
time, I promise) - you'll see a Library-Morse item inside the File > Sketchbook > Examples menu 
containing your example. You might want to add some comments that better explain how to use your 
library. 

If you'd like to check out the complete library (with keywords and example), you can download it: 
Morse.zip. 

That's all for now but I'll probably write an advanced library tutorial soon. In the meantime, if you have
any problems or suggestions, please post them to the Software Development forum. 

For more information, see the API Style Guide for information on making a good Arduino-style API for
your library. 

7

https://www.arduino.cc/en/Reference/APIStyleGuide
http://www.arduino.cc/cgi-bin/yabb2/YaBB.pl?board=dev
https://www.arduino.cc/en/uploads/Hacking/Morse.zip
https://www.arduino.cc/en/Hacking/LibraryTutorial?action=sourceblock&num=13


How to write an Arduino library.

Arduino Style Guide for Writing Libraries
This is a style guide to writing library APIs in an Arduino style. Some of these run counter to 
professional programming practice. We’re aware of that, but it’s what’s made it possible for so many 
beginners to get started with Arduino easily. So please code with these principles in mind. If you have
suggestions on how to make Arduino libraries clearer for that core audience, please jump in the 
discussion. This is a work in progress. 

Be kind to the end user. Assume you are writing an API for an intelligent person who has not 
programmed before. Come up with a clear mental model of the concept you’re working with, and the 
terms and functions you will use. 

Match your API to the underlying capabilities. You don’t want to expose implementation details to 
the user but you also don’t want an API that suggests an inaccurate mental model of the possibilities.
For example, if there are only a few possible options for a particular setting, don’t use a function that 
takes an int, as it implies you can use any value you want. 

Organize your public functions around the data and functionality that the user wants. Quite 
often, the command set for a particular electronic module is overly complicated for the most common 
uses, or can be re-organized around higher level functionality. Think about what the average person 
thinks the thing does, and try to organise your API functions around that. Adafruit's BMP085 library is 
a good example. The readPressure() command performs all the necessary steps to get the final 
pressure. The library wraps this commonly executed series of functions into a high-level single 
command which returns the value the user's looking for in a format she expects. It abstracts away not
only the low-level I2C commands, but also the mid-level temperature and pressure calculations, 
while still offering those mid-level functions as public functions for those who want them. 

Use full, everyday words. Don’t be terse with your function names or variables. Use everyday terms
instead of technical ones. Pick terms that correspond to popular perception of the concept at hand. 
Don’t assume specialized knowledge. For example, this is why we used analogWrite() rather than 
pwm(). Abbreviations are acceptable, though, if they’re in common use or are the primary name for 
something.For example, “HTML” is relatively common and “SPI” is effectively the name of that 
protocol (“serial-peripheral interface” is probably too long). (“Wire” was probably a mistake, as the 
protocol it uses is typically called “TWI” or “I2C”.) 

Avoid words that have different meanings to the general public. For example, to programmers, 
an error is a notification that something happened. To the general public, errors are bad things. 

When you have to use a domain-specific term, write a sentence or two describing it to the 
general public FIRST. You’ll likely come across a better term, and if not, you’ll have started the 
documentation on your library. 
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Document and comment as you go. When writing examples and documentation, follow this style 
guide: http://arduino.cc/en/Reference/StyleGuide 

Use the established core libraries and styles. 

• Use read() to read inputs, and write() to write to outputs, e.g. digitalRead(), analogWrite(), etc. 

• Use the Stream.h and Print.h libraries when dealing with byte streams. If it’s not appropriate, 

at least try to use its API as a model. For more on this, see below 
• For network applications, use the Client and Server libraries as the basis. 

• Use begin() to initialize a library instance, usually with some settings. Use end() to stop it. 

Use camel case function names, not underscore. For example, analogRead, not analog_read. Or 
myNewFunction, not my_new_function. We've adopted this from Processing.org for readability's 
sake. 

LONG_CONSTANT_NAMES_FULL_OF_CAPS are hard to read. Try to simplify when possible, 
without being terse. 

Try to avoid boolean arguments. Instead, consider providing two different functions with names the
describe the differences between them. 

Don’t assume knowledge of pointers. Beginning users of C find this the biggest roadblock, and get
very confused by & and *, so whenever you can avoid having them hanging out in the API, do so. 
One way is to pass by reference using array notation rather than * notation, for example. 

   void printArray( char* array);

can be replaced by 

    void printArray(char[] array);

Though there are some libraries where we pass pointers by using structures like const chars, avoid 
anything that requires the user to pass them. For example,rather than: 

  foo.readAccel(&x, &y, &z);

use something like this: 

   xAxis = adxl.readX();
   yAxis = adxl.readY();
   zAxis = adxl.readZ();

When using serial communication, allow the user to specify any Stream object, rather than hard-
coding "Serial". This will make your library compatible all serial ports on Mega and the Due, and can 
also use alternate interfaces like SoftwareSerial. The Stream object can be passed to your library's 
constructor or to a begin() function (as a reference, not a pointer). See Firmata 2.3 or XBee 0.4 for 
examples of each approach. 
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When writing a library that provides byte-stream communication, inherit Arduino's Stream class, so 
your library can be used with all other libraries that accept Stream objects. If possible, buffer 
incoming data, so that read() immediately accesses data the buffer but does not wait for more data to
arrive. If possible, your write() method should store data to a transmit buffer, but write() must wait if 
the buffer does not have enough space to immediately store all outgoing data. The yield() function 
should be called while waiting. 

Here are a few libraries that are exemplary from Adafruit. She breaks the functions of the devices 
down into their high-level activities really well. https://github.com/adafruit/Adafruit-BMP085-Library 
https://github.com/adafruit/DHT-sensor-library  

This does a nice job of abstracting from the Wire (I2C) library: https://github.com/adafruit/RTClib 
Reference Home 

Corrections, suggestions, and new documentation should be posted to the Forum. 

The text of the Arduino reference is licensed under a Creative Commons Attribution-ShareAlike 3.0 
License. Code samples in the reference are released into the public domain. 
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How to Write Libraries for Arduino

This tutorial explains how to create C++ libraries in Arduino.

• Introduction 

• Step 1. Setting up 

• Step 2. The Header 

• Step 3. The Body 

• Step 4. The Keywords 

• Conclusion & Downloads 

Introduction

For this example we will create a toy library called Fader. As the name suggests, it will allows us to have fading
timers which we can query at any time. Since Arduino libraries are written in C++, we need to create two files:
Fader.h and Fader.cpp. They will contain the header and the body of the class Fader, respectively. The Arduino IDE
comes with its own C++ compiler, so you won’t need any other additional tool for this tutorial.

Step 1. Setting up

Before start writing our source codes, we have to find the folder which Arduino uses for its libraries. For
Windows users is usually in C:\Users\<user name>\Documents\Arduino\libraries. You can find your folder by checking the
Sketchbook location in the Arduino Preferences window. Browse to that folder and look for libraries.
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Within that folder, you have to create another folder with the name of your library; in this example, Fader. This
folder will contain all the files we need.

Step 2. The Header

Arduino’s headers

If you are unfamiliar with C++, the header is like a summary of what the library contains. Every time we want
to use our library, we need to import its header; by doing so, the compiler knows which functions are available.

Almost every Arduino library header looks like this:

#ifndef Fader_h 
#define Fader_h 

#if ARDUINO >= 100 
   #include "Arduino.h" 
#else 
   #include "Wprogram.h"
   #include "pins_arduino.h" 
   #include "WConstants.h" 
#endif
 // Your class header here... 

#endif
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#ifndef Fader_h
#define Fader_h
 
#if ARDUINO >= 100
  #include "Arduino.h"
#else
  #include "WProgram.h"
  #include "pins_arduino.h"
  #include "WConstants.h"
#endif
 
// Your class header here...
 
#endif

Lines 1,2 and 14 are used to prevent this header from being included twice, and they are quite common in C+
+. Lines 4-10 are necessary if you want to use the standard Arduino functions or constants from within your
code.

The Code

The header contains the definition of the Fader class, and it indicates which methods and attributes are 
available to use.

class Fader { 
public: 
Fader(); 

void init(float initial); 
void fadeTo(float value, unsigned long duration); 
float getFade(); 

private: 
 unsigned long _startTime; 
float _startValue; // Start from this value 

unsigned long _stopTime; 
float _stopValue; // Stop at this value 

float lerp(float m1, float M1, float m2, float M2, float v1); 
};

13



How to write an Arduino library.

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17

class Fader {
  public:
    Fader();
    
    void init(float initial);
    void fadeTo(float value, unsigned long duration);
    float getFade();
 
  private:
    unsigned long _startTime;
    float _startValue; // Start from this value
 
    unsigned long _stopTime;
    float _stopValue;   // Stop at this value
 
    float lerp(float m1, float M1, float m2, float M2, float v1);
};

The public methods that we can invoke on a Fader object are just fadeTo and getFade. The remaining components 
are declared as private and will be used internally.

Step 3. The Body

The body of the library is where the code actually is. It starts with #include "Fader.h", and then it provides a body
for all the methods that have been defined in the header. For instance, the syntax Fader::fadeTo indicates that we
are going to provide the body for the function fadeTo of the class Fader.

#include "Fader.h" 

Fader::Fader() { 
} 

Fader::init(float initial)
 {
 _startTime = millis() -1; 
 _startValue = initial -1; 

_stopTime = _startTime; 
_stopValue = initial;
 }
 void Fader::fadeTo(float value, unsigned long duration) 
{ 
_startTime = millis();
 _startValue = getFade(); 

_stopTime = _startTime + duration; 
_stopValue = value;

 }
 float Fader::getFade() 
{
 unsigned long currentTime = millis();
 float currentValue = lerp(_startTime, _startValue, _stopTime, _stopValue, currentTime); 
currentValue = constrain(currentValue, _startValue, _stopValue); 
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return currentValue; 
}

 // Linear interpolation 
float Fader::lerp (float m1, float M1, float m2, float M2, float v1) 
{
 float d = M1 - m1; 
float c = (M2 - m2) / d; 
float o = ( -(M2 * m1) + (m2 * m1) + m2 * d) / d; 
return v1 * c + o; 

}
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#include "Fader.h"
 
Fader::Fader()
{
}
 
Fader::init(float initial)
{
  _startTime = millis() -1;
  _startValue = initial -1;
 
  _stopTime = _startTime;
  _stopValue = initial;
}
 
void Fader::fadeTo(float value, unsigned long duration)
{
  _startTime = millis();
  _startValue = getFade();
  
  _stopTime = _startTime + duration;
  _stopValue = value;
}
 
float Fader::getFade()
{
  unsigned long currentTime = millis();
  float currentValue = lerp(_startTime, _startValue, _stopTime, 
_stopValue, currentTime);
  currentValue = constrain(currentValue, _startValue, _stopValue);
  return currentValue;
}
 
// Linear interpolation
float Fader::lerp (float m1, float M1, float m2, float M2, float v1)
{
  float d  = M1 - m1;
  float c  = (M2 - m2) / d;
  float o = ( -(M2 * m1) + (m2 * m1) + m2 * d) / d;
  return v1 * c + o;
}

Step 4. The Keywords

The editor of Arduino is notoriously bad when it comes to semantic syntax highlighting. You can help uses by
adding an extra file in the library folder called keywords.txt.

####################################### # Syntax Coloring Map For Fader ####################################### 
####################################### # Datatypes (KEYWORD1) ####################################### Fader KEYWORD1 
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####################################### # Methods and Functions (KEYWORD2) ####################################### init 
KEYWORD2 fadeTo KEYWORD2 getFade KEYWORD2 ####################################### # Constants (LITERAL1) 
#######################################
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#######################################
# Syntax Coloring Map For Fader
#######################################
 
#######################################
# Datatypes (KEYWORD1)
#######################################
 
Fader KEYWORD1
 
#######################################
# Methods and Functions (KEYWORD2)
#######################################
 
init    KEYWORD2
fadeTo KEYWORD2
getFade KEYWORD2
 
#######################################
# Constants (LITERAL1)
#######################################

This step is totally optional, but allows to give specific keywords a different colour.

Step 5. Using the library

The final step is to use the library. To do that in an Arduino sketch, we need to import Fader.h first.

#include "Fader.h" 

Fader fader = Fader();
 
int led = 9; // the pin that the LED is attached to 
int fadeDuration = 1000; // 1 second // the setup routine runs once when you press reset: 

void setup() { // declare pin 9 to be an output: 
pinMode(led, OUTPUT); fader.init(255);

 } // the loop routine runs over and over again forever: 

void loop() { // Get the current fade 
int fade = (int) fader.getFade(); 
analogWrite(led, fade); // Restarts the fade, if necessary 
if (fade == 0) fader.fadeTo(255, fadeDuration); 

if (fade == 255) fader.fadeTo(0, fadeDuration); 

}
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#include "Fader.h"
Fader fader = Fader();
 
int led = 9;              // the pin that the LED is attached to
int fadeDuration = 1000;  // 1 second
 
// the setup routine runs once when you press reset:
void setup()  { 
  // declare pin 9 to be an output:
  pinMode(led, OUTPUT);
  fader.init(255);
} 
 
// the loop routine runs over and over again forever:
void loop()  { 
  // Get the current fade
  int fade = (int) fader.getFade();
  analogWrite(led, fade);
  
  // Restarts the fade, if necessary
  if (fade == 0)
    fader.fadeTo(255, fadeDuration);
  if (fade == 255)
    fader.fadeTo(0, fadeDuration);
}

This code reviews the “Fade” example provided in the Arduino Examples folder.

Installing the library

If you zip the folder where all the library files are, you can redistribute that file to other developers. Arduino
has an option to import external libraries; it will extract the archive and place the files in the right folder.
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